DOCUMENT ASSEMBLY FOR LAWYERS: USING TEMPLATES AND SOFTWARE THAT CAN DRAFT DOCUMENTS FOR YOU

Presented by the American Bar Association Law Practice Division, Division for Public Services, Young Lawyers Division and Center for Professional Development
Submit a Question

Visit https://americanbar.qualtrics.com/SE/?SID=SV_2uB91twXeymw6FL&pCode=CE1608LPI to submit a question on the content of this course to program faculty. We’ll route your question to a faculty member or qualified commentator in 2 business days.

The materials contained herein represent the opinions of the authors and editors and should not be construed to be the action of the American Bar Association Law Practice Division, Division for Public Services, Young Lawyers Division or Center for Professional Development unless adopted pursuant to the bylaws of the Association.

Nothing contained in this book is to be considered as the rendering of legal advice for specific cases, and readers are responsible for obtaining such advice from their own legal counsel. This book and any forms and agreements herein are intended for educational and informational purposes only.

© 2016 American Bar Association. All rights reserved.

This publication accompanies the audio program entitled “Documents Assembly for Lawyers: Using Templates and Software That Can Draft Documents for You” broadcast on August 24, 2016 (event code: CE1608LPI).
Document Assembly for Lawyers: Using Templates and Software That Can Draft Documents for You
Document Assembly for Lawyers: Using Templates and Software That Can Draft Documents for You

Table of Contents

I. Legal Drafting Methodologies .................................................................................................................. 1
   A. Find, Rename and Modify ....................................................................................................................... 1
      1. High Margin for Error ......................................................................................................................... 1
      2. Slow .................................................................................................................................................... 1
      3. Errors of Omission ............................................................................................................................ 1
      4. Errors of Inclusion ............................................................................................................................. 1
      5. Compromised Documents .................................................................................................................. 1
   B. Gold Standard Templates ....................................................................................................................... 1
   C. Gold Standards + Word Processor Automation ..................................................................................... 2
   D. Gold Standards + Case/Matter Management Software .......................................................................... 2
   E. Subscription Drafting Systems ............................................................................................................... 2
   F. Gold Standards + Document Assembly Software ................................................................................... 3
      2. How It Works - Big Picture ................................................................................................................. 4
      3. Document Assembly Options ............................................................................................................. 5

II. "Disruptive" Legal Technologies ............................................................................................................ 6
   A. Disruptive Technology In General ........................................................................................................ 6
   B. Disruptive Legal Technology Definition ............................................................................................... 7
   C. Document Assembly Is Disrupting the Legal Market ............................................................................ 7

III. Why Template Building is Critical for All Law Offices ......................................................................... 7
   A. Word Processor Based (Inexpensive and Easy) ...................................................................................... 7
   B. Error Reduction ................................................................................................................................... 7
   C. Drafting is a Mission Critical Function for Most Lawyers ..................................................................... 8
   D. The Hyper-Competitive Legal Market Penalizes Lawyers Who Work Slowly ................................. 8
   E. Speed Gains ........................................................................................................................................ 8
      1. Draft a Will Using Find, Rename & Modify ......................................................................................... 8
      2. Draft a Will Using a Gold Standard Template .................................................................................... 8
      3. Draft a Will Using Document Assembly ............................................................................................ 8
   F. Templates Allow You To Share What You Know With Others ............................................................... 8
IV. Rules for Template Building ........................................................................................................ 9
   A. One Document Per Instrument .............................................................................................. 9
   B. Finding Your Documents ..................................................................................................... 11
      1. Windows Options ........................................................................................................ 12
         a. Copernic Desktop Search ......................................................................................... 12
         b. dtSearch .................................................................................................................. 12
         c. Filehand .................................................................................................................. 12
         d. Windows Instant Search ......................................................................................... 12
      2. Apple/Mac Search Program Options .............................................................................. 12
         a. HoudahSpot ............................................................................................................ 12
         b. Path Finder ............................................................................................................. 12
         c. Spotlight Search (Mac OS X) ................................................................................ 12
         d. EasyFind ............................................................................................................... 13
      3. What Search Programs Do .............................................................................................. 13
   C. Ascertaining Differences Between Documents ................................................................. 13
      1. Step 1 - Fix Balloons ...................................................................................................... 13
      2. Step 2 - Set Your Compare Options ............................................................................. 14
      3. Step 3 - Compare Versions ......................................................................................... 16
      4. Step 4 - Show or Hide the Source Documents .............................................................. 17
   D. Annotating Your Master ..................................................................................................... 17
      1. Chunking It Out ........................................................................................................... 18
      2. Blending It .................................................................................................................. 18
   E. Create Drafting Checklists for Complex Documents ........................................................... 19
   F. Create "Real" Templates ..................................................................................................... 19

V. How Microsoft Word Templates Work ................................................................................. 20
   A. Template Definition .......................................................................................................... 20
   B. Why You Need to Use Templates ..................................................................................... 20
   C. Two Basic Types of Templates in Word ............................................................................ 20
      1. Global Templates ....................................................................................................... 20
      2. Document Templates ................................................................................................. 20
   D. Normal Template (Default) ............................................................................................. 21
   E. Creating Templates .......................................................................................................... 22
   F. Modify a Template .......................................................................................................... 23
   G. Sharing Templates .......................................................................................................... 24

VI. Word Processor Functionality You Must Incorporate Into Your Templates ....................... 25
   A. Automatic Paragraph Numbering .................................................................................... 25
1. How Multilevel Paragraph Numbering Works............................................. 25
2. Use Multilevel Numbering In Every Circumstance ................................ 25
3. How To Set Up a Multilevel Paragraph Numbering Scheme ..................... 26
4. Add Spacing Between Numbered Paragraphs ........................................... 29
5. Make All Paragraphs Double Spaced ....................................................... 29
6. Restart Numbering at 1 ........................................................................ 29
7. How To Make Changes To Your Numbering Scheme ................................ 29
8. Turn Numbering Off ............................................................................. 30

B. Paragraph Cross References That Automatically Update ......................... 30
1. Automatic Paragraph Number Is a Required Prerequisite ......................... 30
2. Insert a Cross Reference Using the "Bookmark" Method ............................ 30
3. You Must Update Your Cross References .............................................. 31

C. Automatic Spacing Between Paragraphs ................................................... 31
1. How To Add Paragraph Spacing ............................................................. 31
2. Spacing Measurements ......................................................................... 32
3. Spacing Before ..................................................................................... 32
4. Spacing After ....................................................................................... 32
5. You Can Type Lines ............................................................................. 32

D. Automatic Tables of Contents ................................................................. 33

E. Automatic Table of Authorities ............................................................... 33
1. In General .............................................................................................. 33
2. Using a Third Party Program .................................................................. 33
3. Using Word's Built-In Feature ................................................................. 33
4. Mark the Citations ................................................................................ 34
5. Generate a Table of Authorities Based on Your Marked Citations ........... 34
6. Page Number Warning .......................................................................... 34
7. Editing Table of Authorities Entries by Editing TOA Fields .................... 35
8. Long Citation Fields ............................................................................. 36
9. Short Citation Fields ............................................................................ 37
10. How Word uses Long and Short Citation Fields ..................................... 37
11. Changing the format or text of the case citation in the Table of Authorities .......................................................... 38
12. Table of Authorities Styles .................................................................. 39
13. Changing or Renaming Categories ....................................................... 39
14. Changing a Citation's Category ............................................................ 41

F. Paragraph Glue ....................................................................................... 41
1. Keeping Text and/or Paragraphs Together .............................................. 41
2. To Keep Paragraphs Together ................................................................ 41
3. To Keep Text within a Paragraph Together ............................................ 43

G. Proper Formatting Defaults ..................................................................... 43
1. How To Fix Word's Formatting Defaults ............................................... 43
G. Person Tasked With Project Does Not Understand the Substantive Law ........ 61
H. Faulty or No Return On Investment ("ROI") Analysis ........................................ 62
   a. Number of people helped .............................................................. 62
   b. Frequency of use ............................................................................. 62
   c. Cost of production .......................................................................... 62
   d. Potential to re-use ........................................................................... 62
   e. Communication efficiencies .......................................................... 62
   f. Increased accuracy ........................................................................... 62
2. Calculating Cost Savings ............................................................................ 62
3. Payback Period .......................................................................................... 63
4. Other Factors Affecting ROI ....................................................................... 63
   a. Will The New Technology Increase The Competence Of Your Staff And Make The Office More Efficient? ................................................................. 63
   b. Will The New Hardware/Software Allow You To Do Something You Couldn't Do Before? ................................................................. 63
   c. Will The Quality Of Your Services Be Improved? ............................... 63
5. Sample Analysis ......................................................................................... 63
Document Assembly for Lawyers: Using Templates and Software That Can Draft Documents for You

I. **LEGAL DRAFTING METHODOLOGIES**: There are six primary methods lawyers utilize when drafting documents. They are broadly classified as follows:

A. **Find, Rename and Modify**: When creating new documents, most lawyers simply start with the last document they created for a similar client and then modify it (cut-and-paste, search-and-replace) to suit the new client. Although this is the most common approach, it has several significant disadvantages:

1. **High Margin for Error**: The margin for error (and therefore malpractice risk) arises from the fact that Find, Rename and Modify is unstructured, relies on memory, assumes the word processor will "catch" all of the items in need of replacement and requires many steps. Memories fail, word processors don't catch everything and more steps create more mistakes and slower drafting.

2. **Slow**: Transcribing voice recordings or handwritten notes and cobbling together provisions from other documents makes the process slow.

3. **Errors of Omission**: It's easy to leave something out you should have added to the starting point document.

4. **Errors of Inclusion**: It's easy to leave something in that you should have taken out.

5. **Compromised Documents**: In adversarial areas of practice, it's likely that the last document you drafted of a particular type was compromised during the negotiation process. Unless you have a photographic memory and can recall every single change that was made, the document you're starting with is fundamentally flawed.

As a result of the foregoing, Find and Fix is characterized by disorganization, mistakes, and inefficiency; and should be avoided whenever possible. This seminar is all about good alternatives to this approach.

B. **Gold Standard Templates**: A much better approach than "Find, Rename & Modify" described above is to pull together the best of what a law office knows into precedent forms. These forms are thereafter always used as the starting point when drafting new documents. The Gold Standards (which is just a term we use internally) identify changeable text and contain every optional provision in the order they could occur, fully annotated. How to build these Gold Standards and the benefits of this approach are more fully described in Chapter III on page 7.
below. This approach is vastly better than Find, Rename & Modify and costs nothing but time to create.

C. **Gold Standards + Word Processor Automation**: Some lawyers take the Gold Standards they’ve built and then improve them by adding in automation features available in their word processor (typically WordPerfect or Word). This can mean utilizing merge functions, "prompt" or "fill-in" fields, macros to expedite the insertion of optional language, and/or better use of Word's AutoText or Quick Parts features or WordPerfect's QuickWords feature. It's fairly easy to create templates and utilize the tools that Word or WordPerfect provides you for automating those templates. Automating the fill-in of names and the like is fairly easy. However, unless you're a programmer, gathering lists (beneficiaries, trustees, personal representatives, etc.), making language conditional and calculating things (such as he/she, him/her, verb conjugation, list punctuation) is extremely difficult, particularly in MS Word. This approach also assumes that you have a mastery of your word processor and know, for example, how to utilize automatic paragraph numbering, auto-calculating cross references, automatic tables of contents and other higher-end features. If these things aren't built into your templates, then you end up spending a lot of time wrestling with formatting issues and paragraph numbering which can significantly off-set any efficiencies you may have otherwise gained by utilizing word processor automation features. Having said all of that, you should be utilizing this approach at a minimum. This approach is far superior to Find, Rename and Modify and a nice improvement on Gold Standards.

D. **Gold Standards + Case/Matter Management Software**: Case Management software primarily aids lawyers in organizing case information and items related to a case like documents, emails, and phone calls. A sometimes overlooked fact is that most case management vendors offer integration options for your Word or WordPerfect templates. In Amicus Attorney, Practice Master and Time Matters, for example, you can store your templates within the case management system. When a document is created within a specific matter, the equivalent of merge codes grabs key information (client names, pleading captions – indeed nearly any of the case related database fields). For high volume practices such as Social Security or Workers Comp, a library of word processing templates with linked case or document management fields can streamline workflow, and make document generation take just seconds.

E. **Subscription Drafting Systems**: Having become frustrated with the inefficiency of Find, Rename & Modify, or the amount of time necessary to develop and maintain the Gold Standards or the Gold Standards Plus approaches, some lawyers simply subscribe to a commercial system.
Subscription systems are widely divergent in terms of sophistication. For example, there are estate planning drafting systems which enable the user to generate incredibly complex, customized documents which are valid in all 50 states. On the other end of the spectrum, I have seen systems which are nothing more than the most basic and simple forms with fill-in-the-blank technology. In my experience, there’s no real link between price and sophistication when it comes to subscription systems. I’ve seen powerful systems that are fairly inexpensive; and I’ve seen simple systems that are pricey. Most Subscription Drafting Systems contemplate that you enter information about your client and in return, the system generates customized documents for that client. Some work in Word or WordPerfect; and some utilize their own custom-built word processor environment. Examples of these systems would be the New York State Bar Association's Residential Real Estate Forms Powered by HotDocs\(^1\) or Wealth Docx\(^2\).

**F. Gold Standards + Document Assembly Software:** Finally, some will take the Gold Standard Templates approach and raise it to another level by utilizing third-party document assembly software in conjunction with their word processor. In effect, these individuals are creating their own commercial drafting systems. In fact, many of the Commercial Systems available are exactly that: a combination of Word and/or WordPerfect and a home-grown or commercially available document assembly program.

1. **What Is Document Assembly?** Most document assembly programs integrate with your word processor and enable you to create sophisticated templates. Those templates typically generate an interview (series of questions) presented to the user. Upon answering the questions, a customized document is instantly generated. In addition to simply filling in blanks, document assembly programs support conditional logic (i.e., include the guardianship paragraph if the client has minor children or adult disabled children), infinite lists, and the ability to calculate text, numbers and dates.

   The on-screen interview is quite powerful because the template designer can control everything about the sequence and content of the interview. With practice, you can reproduce your entire decision tree in the template and build in safe-guards that walk even novice users through the assembly process. An example of how an interview looks is shown below:


\(^2\) See [https://www.wealthcounsel.com/software-for-attorneys/wealthdocx](https://www.wealthcounsel.com/software-for-attorneys/wealthdocx)
2. **How It Works - Big Picture:** Using HotDocs as an example, the program allows users to replace changeable text with variables (i.e., «Testator Name», «Testator Street Address»), make the inclusion of text (words, sentences, paragraphs, etc.) conditional, gather (infinite) lists, and automatically calculate dates, text and numbers.

By "lists", I mean that the template can gather and process multiple records. This is particularly important with legal documents because there are almost always parties and you never know how many there will be. For example, in a deed, you have grantors and grantees. There could be more than 1 of each. In estate planning documents, there may be multiple children listed, executors/personal representatives, beneficiaries, guardians, or trustees. All of those things are lists. Good document assembly software lets you enter as many parties as necessary and based upon how many you enter, the template will produce correct language. For example, depending upon what the user enters into a list of children in a Will, the document may say:

"Barron Henley has no children." or

"Barron Henley has one child, Ariel, age 20." or
"Barron Henley has two children, Ariel, age 20 and Alexis, age 18."
or

"Barron Henley has three children, Ariel, age 20, Alexis, age 18 and Rylee, age 16."
The point is that whatever the user enters, the template produces the correct language and verb conjugation; and it doesn't matter how many there are.

With each new variable, you create a corresponding question (prompt) which is presented to the user during the assembly process. Generating a new document is a simple matter of answering the questions presented by the template. After the questions are answered, the completed document appears on the screen (in Word or WordPerfect), ready edit, save, print, etc.

After a document is assembled, HotDocs allows users to save the answers entered for one document so that they can be used to assemble other documents which use the same information. In this manner, users simultaneously decrease the margin for error while eliminating time wasted on redundant data entry. The document produced by HotDocs is a plain word processor document and can be edited and stored like any other document.

3. **Document Assembly Options**: There are several available document automation applications and while each has its own unique way of handling the task, they all are very capable and able to achieve the objectives we discuss below. Each of them work with Word or WordPerfect or both. Some provide the ability to automate PDF forms. Because HotDocs continues to dominate the market and both of us are most familiar with it we refer to and show examples from HotDocs throughout this article but we could just as easily be referring to any of these applications. It is highly recommended that you explore the various options and decide for yourself which application best meets your practice needs in terms of availability, functionality and cost. Here are some options:

- HotDocs - www.hotdocs.com
- TheFormTool & Doxserá - www.theformtool.com
- ContractExpress - http://contractexpress.com
- Rapidocs - www.rapidocs.com
II. "DISRUPTIVE" LEGAL TECHNOLOGIES:

A. Disruptive Technology In General: Yes, I know that Wikipedia is not necessarily correct on some issues, but this definition is built from multiple sources and is one of the best I’ve seen of the general term "disruptive technology":

"Disruptive technology and disruptive innovation are terms used in business and technology literature to describe innovations that improves a product or service in ways that the market does not expect, typically by being lower priced or designed for a different set of consumers.

Disruptive technologies are particularly threatening to the leaders of an existing market, because they are competition coming from an unexpected direction. A disruptive technology can come to dominate an existing market by either filling a role in a new market that the older technology could not fill (as cheaper, lower capacity but smaller-sized flash memory is doing for personal data storage in the 2000s) or by successively moving up-market through performance improvements until finally displacing the market incumbents (as digital photography has largely replaced film photography)."³

A few examples:

<table>
<thead>
<tr>
<th>Disruptive Technology</th>
<th>Displaced Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop publishing</td>
<td>Traditional publishing</td>
</tr>
<tr>
<td>Steamships</td>
<td>Sailing ships</td>
</tr>
<tr>
<td>Telephones</td>
<td>Telegraphs</td>
</tr>
<tr>
<td>Word processor</td>
<td>Typewriter</td>
</tr>
<tr>
<td>Semiconductors</td>
<td>Vacuum tubes</td>
</tr>
<tr>
<td>Contact lenses</td>
<td>Eye glasses</td>
</tr>
<tr>
<td>Refractive eye surgery</td>
<td>Contact lenses</td>
</tr>
</tbody>
</table>

Disruptive Technology | Displaced Technology
---|---
Accommodating lens implants | Refractive eye surgery
Internet store | Bricks & mortar store

B. **Disruptive Legal Technology Definition**: As it relates to law, an excellent and brief discussion of this term comes from Richard Susskind:

"My experience of working with law firms and in-house legal departments leads me to claim that there is remarkable scope for greater and beneficial deployment of technology. I also contend that for some lawyers there are existing and emerging technologies whose widespread adoption will effectively render them redundant. (Much the same has happened in many other sectors; lawyers are not immune from the destructive effects of the internet and IT revolutions.)

I call technologies that threaten the work of today's lawyers and law firms 'disruptive legal technologies'. They do not support or complement current legal practices. They challenge and replace them, in whole or in part."\(^4\)

C. **Document Assembly Is Disrupting the Legal Market**: Document Assembly is disruptive because it significantly reduces the amount of time that lawyers spend drafting documents. For lawyers who only bill hours, this obviously reduces the amount they can charge (one of the big reasons Document Assembly isn't a standard drafting method for all private law firms). For lawyers who adopt a flat-fee billing approach, Document Assembly can push their effective hourly rates into the stratosphere (see paragraph VIII.E. below for examples of this). For in-house or corporate lawyers, the revenue penalty is avoided while cost savings are achieved; so it is positive on all fronts. It is still disruptive technology to in-house lawyers because it will fundamentally change the way documents are generated.

III. **WHY TEMPLATE BUILDING IS CRITICAL FOR ALL LAW OFFICES**: In order to capture your office's intellectual capital and put it into a usable form, you need to spend time creating "gold-standard" templates which represent the best of what your firm knows.

A. **Word Processor Based (Inexpensive and Easy)**: You want your templates to be word processor documents so they can easily be edited and updated later.

B. **Error Reduction**: Building Gold Standards eliminates all of the potential causes of error described above under Find, Rename and Modify.

---

\(^4\) Susskind, Richard, "Only A Foolhardy Lawyer Will Fail To Embrace Change, In the final part of The End of Lawyers?, The Author Addresses His Critics And Says They Have Missed The Point." *Times Online*, November 26, 2007, [http://business.timesonline.co.uk/tol/business/law/article2931356.ece](http://business.timesonline.co.uk/tol/business/law/article2931356.ece)
C. **Drafting is a Mission Critical Function for Most Lawyers:** There are many practice areas in which drafting is the primary task engaged in by the lawyer; and in many cases, the service rendered is primarily a set of documents (estate planning, etc.). The Find, Rename and Modify drafting method described above is incredibly inefficient, slow and has a high margin for error. One could argue that it is inappropriate to rely on such inadequate drafting methods considering the importance of the task.

D. **The Hyper-Competitive Legal Market Penalizes Lawyers Who Work Slowly:** For many years, the legal industry had little incentive nor ability to change the inefficient Find, Rename and Modify method of drafting. With hourly billing predominant, one who takes a bit longer to get a set of documents together isn’t penalized (in fact, they might be rewarded). Furthermore, there were few alternatives from a technological standpoint.

However, the emergence of flat fee billing and other non-hourly methods began creating an incentive to generate documents more quickly. Competition has increased significantly in the legal industry in the last 25 years; and technology has enabled firms to handle much higher volumes than they could in past decades thereby forcing administrative tasks like drafting to become more efficient. The paradigm shift is that lawyers are now looking for ways to generate documents in a quicker fashion without sacrificing accuracy. Sophisticated form building is a great way to achieve those objectives. Document assembly technology allows you to take it even further in terms of efficiency.

E. **Speed Gains:** Imagine a tool that could save you hours each day. If you’re buried in drafting and it’s a primary stressor in your work load, then template building can make a big difference. Here's an example regarding Will drafting:

1. **Draft a Will Using Find, Rename & Modify:** This can easily take an hour depending upon complexity and has a high margin for error.

2. **Draft a Will Using a Gold Standard Template:** This can take half the time (30 minutes) and improve accuracy.

3. **Draft a Will Using Document Assembly:** This may take 3 - 5 minutes and offers the highest accuracy.

F. **Templates Allow You To Share What You Know With Others:** Knowledge Management is the ability of a lawyer to share what she knows with others in her firm. Unfortunately, a lot of what most lawyers know is wrapped up in documents they've created. Processes and drafting methodologies are often never written down anywhere. However, building templates allows you to take much of what you and your colleagues collectively know about a practice area and perform a "brain dump" into an expert drafting system. For example, assume you have 5
lawyers in your real estate department and they collaborate to build sophisticated gold standard templates for leases. New associate Jim needs to draft a lease in which your firm represents the landlord of a strip mall and the proposed new tenant is a restaurant business. The templates and drafting guides could skillfully guide Jim through the process, making sure that he a) is using the latest and best form your firm has prepared; and b) addresses all issues that should be addressed in a lease of this type (strip mall, food service tenant, your firm is representing the landlord, etc.). Review by the partner takes minutes instead of hours because the first draft was so well done, even by a relative rookie. The drafting system ensures that the firm's collective knowledge is utilized in every deal; even though the documents are generated in much less time than the old Find, Rename & Modify method.

IV. **RULES FOR TEMPLATE BUILDING:** You cannot add document assembly to the equation until you have built plain word processor templates (Gold Standards). Once you have Gold Standards built, you're ready for the next step. However, even if you decide not to implement document assembly technology, building Gold Standards is still significantly better for your practice than the Find, Rename & Modify approach described previously.

**A. One Document Per Instrument:** Let's say you have multiple model documents you rely on for Wills which are supposed to be the same but for some fact pattern variation. For example, you might have a dispositive will, a pour-over will, a married person will, a single person will, a married with kids will, a will that contains a special needs trust, etc. Unless you're assigned someone to the specific job of template maintenance and this individual has obsessive attention to detail, I can promise you that the documents contain unintended differences. In my professional experience, it's impossible to maintain a set of documents over time with perfect consistency except for the provisions that are supposed to be different. The way to avoid this is to create one template per type of instrument. Going back to the Will example, you want a single Word document which contains every single provision that could occur in a Will, in the order it would occur. You then identify changeable text and annotate the document so anyone using the template knows when an option starts and ends. For example, consider the following example of an annotated Will:
Last Will and Testament of
<Testator Name>

I, <Testator Name>, declare this to be my Last Will and revoke all other Wills and Codicils that I have made.

Option 1: Unmarried with children

At the time of making this Will I am single, and have <Num Children> children: namely, <Child 1 Name>, born <Child 1 DOB>, and <Child 2 Name>, born <Child 2 DOB>. Adjust accordingly if only one child or more than two.

Option 2: Unmarried with no children

At the time of making this Will I am single and I have no children.

Option 3: Married with joint children

At the time of making this Will I am married to <Spouse Name>, and we have <Num Children> children: namely, <Child 1 Name>, born <Child 1 DOB>, and <Child 2 Name>, born <Child 2 DOB>. Adjust accordingly if only one child or more than two.

Option 4: Married with children from separate marriages/relationships

At the time of making this Will I am married to <Spouse Name>, and we have no children together. I have <Num Testator Children> children from a previous relationship: namely, <Testator Child 1 Name>, born <Testator Child 1 DOB>, and <Testator Child 2 Name>, born <Testator Child 2 DOB>. My <wife/husband> has <Num Spouse Children> children from a previous relationship: namely, <Spouse Child 1 Name>, born <Spouse Child 1 DOB>, and <Spouse Child 2 Name>, born <Spouse Child 2 DOB>.
Finding Your Documents: You may have read the foregoing point and thought to yourself, "that would be great if I could FIND all of my past work!" This is where search utilities can help you out. Search utilities are software applications that will allow you to search though all of the documents (Word, WordPerfect, etc.) that you've ever created and locate specific ones based upon the words they CONTAIN rather than what you called them or what folder they're stored in. For example, let's say you need to draft an Oklahoma Discretionary and Special Needs Trust but you can't remember the last client for whom you drafted one. You may remember that such trusts are authorized by 60 O.S. §§175.81 - 174.92 and that 60 O.S. §175.82 is mentioned in the text of the trust. You could do a search for "60 O.S. §175.82" and instantly find every single document you've ever created which contains that phrase. Anyway, here is a quick summary of some options for a search utility:
1. **Windows Options**: Even if you've created a good file naming convention, you'll still need help finding some documents. Now that you've created searchable PDFs, you can search through all of them at once, quickly, by searching for particular words. Here is a survey of your options:

   a. **Copernic Desktop Search**: RECOMMENDED - See www.copernic.com. There are three versions of Copernic, Home (FREE), Professional ($49.95) and Corporate ($59.95). Unless you're installing it in a very large firm, you only need the Professional version. You can try the free home version, but one of the limitations of the free version is that it does not search network drives. So unless you're keeping all of your files on the C:\ of the computer you're using (I certainly hope you're not doing this), the Home version will not help you very much. Copernic will search all of your files (Word, Excel, PowerPoint, PDF, HTML, WordPerfect, text and another 150 types of files). It will also search Outlook or Outlook Express email and any attachments to email.

   b. **dtSearch**: RECOMMENDED: See www.dtSearch.com - $199 - one of the most sophisticated and fast search engines I've ever seen. It provides the most search options and file types that it can recognize. If you need industrial strength search capability involving enormous numbers of documents, this is your program.

   c. **Filehand**: See www.filehand.com - FREE. Instantly search for files on your computer, by content. See the extracts of the files you found, even for PDF files. Scroll through the extracts so you can quickly find the information you're looking for. Find the file you are looking for, even when many files match, because Filehand Search sorts the results by relevance. Do complex Boolean searches and searches by phrase. Use it all the time because it is so simple to use!

   d. **Windows Instant Search** (Windows Vista and Windows 7): For more information on this, see http://tinyurl.com/6j584x. This is included with all versions of Vista.

2. **Apple/Mac Search Program Options**:

   a. **HoudahSpot**: $30 - see www.houdah.com/houdahSpot

   b. **Path Finder**: $40 - see http://www.cocoatech.com/pathfinder/

   c. **Spotlight Search (Mac OSX)**: This is included with the Mac OSX operating system. For more information, see http://support.apple.com/kb/HT2531
d. **EasyFind**: Free - see http://tinyurl.com/d6se856

3. **What Search Programs Do**: Briefly, they read through all of the documents you’ve created in a word processor or scanned as PDFs, and they build an index of the text contained therein. Once the index is built, you can search through all of those documents by either file-name OR the words contained inside them. When searching for words contained inside the documents, you can use the standard Boolean logic (and, or, not, etc.). If you try a search utility, it will not instantly be able to search through all of your documents. You have set up the programs so they know where your documents are and then give the program a chance to build the index. This can take an entire day to build it initially depending upon how many documents you have. After the index of words is built in the first place, the search utility will easily be able to maintain it going forward.

C. **Ascertaining Differences Between Documents**: The only way to do this accurately is to compare versions of documents using your word processor to produce a redline. Here’s how you do it with Microsoft Word:

1. **Step 1 - Fix Balloons**: By default, Word shows deleted text in balloons in the right margin. Most people find this annoying. If you would like to see deleted text red-lined in the body of the document, follow these steps:

   **Word 2007/10**: Click the Review ribbon ➔ Tracking group ➔ click the bottom half of the Track Changes button ➔ Change Tracking Options... ➔ choose Only for comments/formatting for the Use Balloons option.

   ![Figure IV-3](image-url)
**Word 2013/16:** Click the Review ribbon ➤ Tracking group ➤ Show Markup button ➤ Balloons ➤ Show only comments and formatting in balloons.

![Figure IV-4](image)

2. **Step 2 - Set Your Compare Options:** You have total control over how Word indicates changes between two documents. To make any changes to the default preferences, in Word 2007/10, click the Review ribbon ➤ Tracking group ➤ bottom of the Track Changes Button down arrow ➤ Change Tracking Options…. In Word 2013/16, click the Review ribbon ➤ Tracking launcher. The option dialog is much smaller in Word 2013/16, but you can pull up the options from Word 2007/10 by clicking the Advanced Options… button.

![Figure IV-5](image)
Figure IV-6
3. Step 3 - Compare Versions:

a. Click the Review ribbon ➤ Compare group ➤ Compare button ➤ Compare….

![Figure IV-7](image1)

b. Click the browse button on the left side of the subsequent dialog and choose the original document. On the right side, click the browse button and choose the document that has been modified. Click the More button. I also normally uncheck Formatting because I really don't care if they changed formatting.

![Figure IV-8](image2)
c. Click OK.

d. Word will then create a new document by merging the original and altered documents and highlighting the differences between the two. At this point, you may want to print or save the new, merged document with a new name.

4. **Step 4 - Show or Hide the Source Documents**: If you want to, you can click the Review ribbon ➤ Compare group ➤ Show Source Documents button (Word 2007) or Compare button ➤ Show Source Document button (Word 2010/13/16) and you'll be able to see the compare document, plus both documents you compared; and they will scroll synchronously.

![Figure IV-9](image)

D. **Annotating Your Master**: You can use one of two approaches for this. We call them "chunking it out" or "blending." Don't ask how we came up with those terms, particularly the first one.
1. **Chunking It Out:** Chunking it out means that you show entire paragraphs in your gold standard as they would look under changing fact patterns. This is easy to follow but makes your templates take up a lot more pages (sometimes 4 times as many). Here’s what it looks like:

   **ARTICLE XI**
   APPOINTMENT OF GUARDIAN OF MINOR CHILDREN

   [if sole initial guardian]
   A. [Guardian name]_________ and ____________ [if co-guardians]. [if married client]If my spouse is deceased and I am survived by minor children, [END IF]I nominate [Guardian Relationship to Testator], ____________, of ________, ________, to serve as the Guardian of the Person of my minor children.

   [otherwise if co-guardians who can serve alone]
   A. ________ and ____________ [if married client]If my spouse is deceased and I am survived by minor children, [END IF]I nominate [Guardian Relationship to Testator], ____________, of ________, ________, and [Guardian Relationship to Testator], ____________, of ________, ________, to serve as the Guardian/Co-Guardians of the Person of my minor children. If either ________ or ________ is unable or unwilling to act as Co-Guardian of the Person of my minor children, then the one who is able to serve shall serve as the sole Guardian of the Person of my minor children.

   [otherwise if co-guardians who cannot serve alone]
   A. ________ and ____________ [if married client]If my spouse is deceased and I am survived by minor children, [END IF]I nominate [Guardian Relationship to Testator], ____________, of _______, _______, and [Guardian Relationship to Testator], ____________, of ________, ________, to serve as the Guardian/Co-Guardians of the Person of my minor children. It is my intention that these nominees act as Guardian of the Person of my minor children only if they are able to act together.

   [end options]

2. **Blending It:** As you can see below, blending it takes up much less space and the idea is to combine the language where possible and annotate so you can see where the differences lie. This is a much better approach, but requires that you break down your language in a more granular manner.

   **ARTICLE XI**
   APPOINTMENT OF GUARDIAN OF MINOR CHILDREN

   A. [Guardian name]_________ and ____________ [if co-guardians]. [if married client]If my spouse is deceased and I am survived by minor children, [END IF]I nominate [Guardian Relationship to Testator], ____________, of ________, ________, [could be co-guardians] to serve as the Guardian/Co-Guardians of the Person of my minor children. [if Co-Guardians and remaining guardian may serve alone]If either ________ or ________ is unable or unwilling to act as Co-Guardian of the Person of my minor children, then the one who is able to serve shall serve.
as the sole Guardian of the Person of my minor children. [end of option] if Co-Guardians and remaining guardian may NOT serve alone [It is my intention that these nominees act as Guardian of the Person of my minor children only if they are able to act together. [end of option]

E. Create Drafting Checklists for Complex Documents: This is part of documenting processes, building in malpractice avoidance into the way you work, and improving accuracy. For example, see below:

<table>
<thead>
<tr>
<th>FINAL DECREED CHECKLIST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decree is:</td>
</tr>
<tr>
<td>□ agreed to</td>
</tr>
<tr>
<td>□ proposed by</td>
</tr>
<tr>
<td>□ P □ R</td>
</tr>
<tr>
<td>□ ordered; hearing date</td>
</tr>
<tr>
<td>□ P attended; R attended</td>
</tr>
<tr>
<td>1. Type of Case:</td>
</tr>
<tr>
<td>□ Divorce granted to</td>
</tr>
<tr>
<td>□ P □ R □ parties</td>
</tr>
<tr>
<td>□ Legal separation granted to</td>
</tr>
<tr>
<td>□ P □ R □ parties</td>
</tr>
<tr>
<td>□ Civil Union Dissolution granted to</td>
</tr>
<tr>
<td>□ P □ R □ parties</td>
</tr>
<tr>
<td>□ Irreconcilable differences</td>
</tr>
<tr>
<td>□ Grounds in Petition; Cross-Petition, if any, dismissed</td>
</tr>
<tr>
<td>2. Parenting Plan and Uniform Support Order: N/A</td>
</tr>
<tr>
<td>□ Parenting Plan &amp; USO attached</td>
</tr>
<tr>
<td>3. Tax Exemptions for Children: N/A</td>
</tr>
<tr>
<td>□ P claims</td>
</tr>
<tr>
<td>_________________________</td>
</tr>
<tr>
<td>□ in all even odd years</td>
</tr>
<tr>
<td>□ R claims</td>
</tr>
<tr>
<td>_________________________</td>
</tr>
<tr>
<td>Claim only if current on child support</td>
</tr>
<tr>
<td>4. GAL fees: N/A</td>
</tr>
<tr>
<td>□ See Order on Appointment</td>
</tr>
<tr>
<td>□ Other: ____________________</td>
</tr>
<tr>
<td>5. Alimony: N/A</td>
</tr>
<tr>
<td>□ P □ R pays $ ________ per ________</td>
</tr>
<tr>
<td>□ Termination: ____________________</td>
</tr>
<tr>
<td>□ Alimony Waiver: Yes No</td>
</tr>
<tr>
<td>6. Health Insurance for Spouse: N/A</td>
</tr>
<tr>
<td>□ Employer-sponsored:</td>
</tr>
<tr>
<td>□ P maintains for R; P pays</td>
</tr>
<tr>
<td>□ P maintains for R; R pays</td>
</tr>
<tr>
<td>□ R maintains for P; R pays</td>
</tr>
<tr>
<td>□ R maintains for P; P pays</td>
</tr>
<tr>
<td>□ Additional provisions: ____________________</td>
</tr>
<tr>
<td>□ Termination: ____________________</td>
</tr>
<tr>
<td>□ Not employer-sponsored:</td>
</tr>
<tr>
<td>□ P maintains for R; P pays; termination: ____________________</td>
</tr>
</tbody>
</table>

Figure IV-10

F. Create "Real" Templates: Word processor templates have a different suffix (.wpt in WordPerfect and .dotx in Word) and they're typically stored in a special folder for templates. They can be made read-only so that users don't accidentally overwrite them with changes. More importantly, they can be shared across your office...
so that everyone is using the same template every time. This also makes updating easier since there's only one template to deal with.

V. **HOW MICROSOFT WORD TEMPLATES WORK**

A. **Template Definition:** A template is a special kind of file that provides a model for the underlying structure (or pattern) of a particular finished document (such as a Deed or Lease or Revocable Trust). Templates may also contain document settings such as AutoText entries, Quick Parts, fonts, key assignments, macros, menus, page layouts, special formatting and styles. When you create a new document based upon a template, you get a copy of the template, but not the template itself. In that manner, templates are protected and cannot be accidentally over-written with changes a user makes to a new document based upon one. In Word 2007, a template can be a .dotx file, or it can be a .dotm file (a .dotm file type allows you to enable macros in the file).

B. **Why You Need to Use Templates:** Maybe you think you have never used templates before, but in reality, every single document you've ever created in Word was based on a template. More importantly, templates are the basic component of any forms system and, if you aren't using a forms system in your practice, you're missing out on one of the fundamental benefits of a word processor. A forms system is important because:

1. It saves an enormous amount of time;
2. It ensures consistency in your firm's documents, the style of which is part of your firm's identity;
3. It increases accuracy; and
4. It helps you convey your knowledge to others in your firm and makes it easier for new employees to learn your firm's drafting style.

C. **Two Basic Types of Templates in Word:** The two basic types of templates are global templates and document templates.

1. **Global Templates:** Global templates contain settings that are available in every Word document. The Normal.dotm template is considered a global template. Remember that templates can store styles, AutoText entries, AutoCorrect entries, macros, toolbars, custom menu settings, and shortcut keys. If you have additional of those items (except styles) you would like to make available at any time in Word, then you can store them in global templates.

2. **Document Templates:** Document templates contain settings that are available only to documents based on that particular template. For
example, if you create a fax cover sheet using a fax cover sheet template, you'll have access to the settings from both the fax cover sheet template as well as the settings in any global template. Word comes with many sample document templates and you can, of course, create your own.

D. **Normal Template (Default):** Unless you specify a different template, Word bases every new document on the Normal template. Calling the template Normal doesn't mean that it's just some ordinary template. The Normal template is actually a file called normal.dotm and it can be customized and modified just like any other. Since normal.dotm is the default global template, much of your Word customization is stored in it (such as AutoText entries, fonts, key assignments, macros, menus, page layouts, special formatting, and styles). If the file normal.dotm is deleted, Word simply creates a new one the next time you run it, but you'll lose all of your macros and other items which were stored in it. Therefore, it is a good idea to make a backup copy of normal.dotm just in case something happens. To determine where Word is storing your normal.dotm file, click the Office Button ➤ Word Options ➤ Advanced ➤ File Locations button under the "General" heading.

![Figure V-1](image-url)
If you click on User Templates, and then click Modify, you'll see the folder where normal.dotm is stored.

![File Locations dialog box]

**Figure V-2**

### E. Creating Templates:

1. Create or open a document you would like to use as a template.
2. Click Office Button/File menu ➤ Save As.
3. Change to the Trusted Templates folder (button on the left side of the Save As dialog)
4. Change the Save As Type drop down at the bottom of the dialog to .dotm or .dotx as appropriate.
5. Enter a file name.
6. Click the Save button.
7. Close the template before trying to use it.
8. Using Your Template

In order to create a new document based upon your template, you must follow these steps:

1. Click Office Button ➤ New....
2. Click My Templates

![Figure V-3](image)

You'll now see Figure V-4. Choose your template and click OK.

![Figure V-4](image)

You'll now have a new, unnamed document on your screen which is based upon the template you chose.

F. **Modify a Template**: To edit a template, go to File, then Open... and change the Files of type designation (at the bottom of the Open dialog) to All Files or
Document Templates. Browse to the folder that contains the template want to edit. Click once on the name of your template and click Open. Make whatever changes you would like to the template, save it and you're done.

G. **Sharing Templates:** You can designate a "public" folder on your server where public templates are stored which are accessible by everyone. Follow these steps:

1. First, create the folder into which you'll save future public templates on a drive that everyone has access to (on your server). Note that only those who add or edit templates need full access to that folder. Everyone who simply uses those templates must only have read and list rights to the shared template folder. We recommend a folder name like x:\Word Templates (where "x" is a network drive.)

2. Now you need to tell Word where to look for these public templates. To do this, open a blank document in Word, click the Office button ➔ Word Options ➔ Advanced ➔ File Locations button under the "General" heading. You'll see the following dialog:

![Figure V-5](image)

3. Note that the Workgroup Templates location is blank. Simply click on that line, then click the Modify button below it. Choose the folder you created on the server and click OK.

4. Note, you'll need to repeat step #3, above, on everyone's computer who will need access to these templates.
5. Add a template to the public folder, then click File►New…►On my computer… and make sure it shows up in the list of available templates.

6. You’re done!

VI. **WORD PROCESSOR FUNCTIONALITY YOU MUST INCORPORATE INTO YOUR TEMPLATES:**
If you don't let the word processor work for you, then editing your templates will still be annoying and no one (including you) will want to use them. Getting the content pulled together is only half the battle. You also need to incorporate the best of what your word processor can do into the templates so the documents are easy to edit and time isn’t wasted manually updating paragraph numbers, cross-references, tables of contents or tables of authority. It's beyond the scope of this class to explain how to set up all of these functions, but this is the list of functions you should be using:

A. **Automatic Paragraph Numbering:**

1. **How Multilevel Paragraph Numbering Works:** Word allows you to set up automatic paragraph numbering schemes up to 9 levels deep. For example, below is a 4 level deep outline:

IX. **TERMINATION.**
A. **Termination Without Cause.** This agreement may be terminated by either party without cause upon ninety (90) days written notice to the other party, it being understood and agreed that such term and notice are reasonable in relation to the scope of this agreement and the undertakings herein provided for.

B. **Termination With Cause.**
1. **Default.** If either party shall default in the performance of any obligation or payment of any indebtedness under this agreement, it shall have 30 days after delivery to it of written notice of such default within which to cure such default. If such defaulting party fails to cure its default within such period of time, then the other party shall have the right to terminate this agreement without further notice.

2. **Other.** This agreement may be terminated by either party at its option and without prejudice to any other remedy to which it may be entitled at law or in equity, or elsewhere under this agreement, by giving ten (10) days written notice of termination to the other party if the latter should:
   i. Be adjudicated a voluntary or involuntarily bankrupt under any chapter of the Bankruptcy Act, as now or hereafter amended;
   ii. Institute or suffer to be instituted any proceeding for a dissolution, reorganization or rearrangement of its affairs;
   iii. Make an assignment for the benefit of creditors;
   iv. Become insolvent or have a receiver of its assets or property appointed; or
   v. Allow any money judgment against him to remain unsatisfied for a period of thirty (30) days or longer.

2. **Use Multilevel Numbering In Every Circumstance:** As described previously, the Bullets button ☐️ and the Numbering button ☐️ only allow ONE level of bullets or paragraph numbers. Therefore, if you start with either one and later determine that you need a sub-level, you simply can't get there from here (and you're going to have to start over with a multilevel numbering scheme). Because of this, we strongly recommend that you use the Multilevel List button ☐️ exclusively for numbering or
bullets of any kind. Multilevel lists can also handle any kind of bullet point and since there are 9 available levels, it's never a problem to add another level (unless you need 10 or more levels).

3. **How To Set Up a Multilevel Paragraph Numbering Scheme**: If you already have paragraphs typed and want to apply paragraph numbering after-the-fact, you can do so by selecting the paragraphs and following the steps below. Otherwise, set up the scheme before you start typing.

   a. Click the Home ribbon ➤ Paragraph group ➤ Multilevel List button (arrow button).

   b. Choose Define New Multilevel List (*not* Define New List Style) at the bottom of the drop down menu.

   ![Image of Define new Multilevel list dialog](image)

   **Figure VI-1**

   c. You will now see the dialog shown above. Here are a couple of things to keep in mind:
d. You can make adjustments to any of the nine levels by simply clicking on the level you want to modify on the top, left side of the dialog.

e. You NEVER type a number in the Enter formatting for number box. Instead, you use the code for the paragraph number which will be inserted when you choose something from the Number style for this level drop down.

f. Font button should only be clicked if you want the formatting for the paragraph number to be different from the paragraph that follows it. Therefore, you should not click the Font button in most cases.

g. Number alignment must always be set to Left, even if you’re centering an article number.

h. “Aligned at” means how far away from the left margin you want your number to appear (see Figure VI-2).

i. “Text indent at” means how far from the left margin you want the text following the number to appear (see Figure VI-2).
j. In Figure VI-3 below, I have configured the dialog for a 3 level deep outline. Since I’m not going to use levels 4 - 9, there’s no need to format them at this point.

![Figure VI-3](image)

k. After you’ve set up the levels the way you want, click OK and you’ll see a paragraph number appear in your document. Just begin typing. When you hit Enter for the next paragraph, you’ll get the next subsequent number automatically.

l. If you want to change the level of the next paragraph to a sublevel (level 2 rather than level 1), you can use any of the following methods:

i. You can promote or demote a paragraph by clicking the Home ribbon ➔ Paragraph group ➔ Decrease/Increase Indent buttons.

ii. If your cursor is at the beginning of a paragraph you can demote it by hitting the Tab key on your keyboard. Promote by hitting Shift + Tab.
iii. If you right-click the paragraph, you can promote it by choosing Increase Indent or demote it by choosing Decrease Indent.

4. **Add Spacing Between Numbered Paragraphs:** If you want to add spacing between the numbered paragraphs, select all of the paragraphs you’ve typed, click Home ribbon ➔ Paragraph launcher. Add a **12 pt Space After** and uncheck Don’t’ add space between paragraphs of the same style. Then click OK.

![Figure VI-4](image)

5. **Make All Paragraphs Double Spaced:** The explanation for adding spacing between numbered paragraphs above assumes you have single spaced paragraphs and would like extra space between each one. If you just want every paragraph double-spaced, don’t add space between them or you’ll end up with too much space between each paragraph when you apply the double space formatting. Instead, select all of the paragraphs you’ve typed, and click Home ribbon ➔ Paragraph launcher ➔ set Line Spacing to double (SK: Ctrl + 2). Of course, you can also apply double spacing by using the Home ribbon ➔ Paragraph group ➔ Line and Paragraph spacing button ; or right-click the selected paragraphs, choosing Paragraph, then switching Line Spacing from single to double.

6. **Restart Numbering at 1:** Right click the paragraph you want to start over again at 1 and choose Restart at 1.

7. **How To Make Changes To Your Numbering Scheme:** If you decide you want to change something about the numbering scheme you’ve created, right-click any paragraph and choose Adjust List Indents. You’ll be presented with the Multilevel list dialog again and you can make changes. Note that you *do not* have to be in the first paragraph to do this. For example, let’s say I have 3 pages of numbered paragraphs when I decide that I want to change the top level of the outline from Arabic (1.) to Roman Numerals (I.). Right click any paragraph in the numbered list, choose Adjust List Indents, click on Level 1, and change Number style for this level from 1, 2, 3, … to I, II, III, … and click OK. As you’ll see the entire list will
change (above and below the paragraph that you right-clicked in the first place).

8. **Turn Numbering Off**: There are several ways to do this:
   
   a. Hit the Backspace key twice; or

   b. Click the Multilevel List button once

B. **Paragraph Cross References That Automatically Update**: Not only is it a huge waste of time to update these manually, but they’re very likely to be incorrect if the document is edited. All versions of Word and WP allow you to set up paragraph cross-references that can be automatically updated.

1. **Automatic Paragraph Number Is a Required Prerequisite**: Now that you have mastered automatic paragraph numbering (see paragraph VI.A above), you are ready to insert cross references. Word provides a simple and convenient way to use cross references, automatically updating them if a paragraph is moved. For instance, in a contract you may have a reference that looks something like "see paragraph II.B.3" at the end of a paragraph. Anyone can type "see paragraph II.B.3" without creating a cross reference, but what happens if paragraph II.B.3 is moved – and it now becomes paragraph II.B.4? Word can solve this problem with 100% accuracy. There are multiple ways to do this, but I’m only going to explain the best way to do it.

2. **Insert a Cross Reference Using the "Bookmark" Method**: Former WordPerfect users are accustomed to inserting a "target" code, a "reference" code and then clicking a button to "generate cross reference." Word uses a similar methodology. In order to use the Bookmark Method, follow these steps:
   
   a. Insert a bookmark somewhere in the paragraph you want to reference (Insert ribbon ➤ Bookmark button ➤ type a name for the bookmark that does not use spaces ➤ click the Add button).

   b. Click on the spot in the document where you would like to insert the cross reference to the paragraph you just added a bookmark to. Place the cursor exactly where the cross reference will be inserted.

   c. Select Insert ribbon ➤ Links group ➤ Cross reference button.
d. Under Reference type, select **Bookmark**. Under Insert reference to, make sure you select **Paragraph Number**. See Figure VI-5 below.

![Cross-reference dialog box](image)

Figure VI-5

e. Click the Insert button to insert the cross reference.

3. **You Must Update Your Cross References:** Cross references do not automatically update just because you edit the document in a way that would cause the cross references to be incorrect. Therefore, it’s important to remember to update them before you finalize the document. You do this by hitting Ctrl + A to select the whole document ➔ Hit F9 to update. This action will update cross references, tables of contents, tables of authority and any other fields in the document.

C. **Automatic Spacing Between Paragraphs:** It is always wrong to create vertical spacing between paragraphs by adding extra hard returns. There is a feature in Word and WP which handles this automatically and eliminates the possibility of alignment errors.

1. **How To Add Paragraph Spacing:** If you want your paragraphs single spaced but you want a double space between each paragraph, you could hit Enter twice after each paragraph. However, this wastes time, creates a lot of unnecessary paragraph marks in your document and creates the possibility that you’ll end up with too much or not enough spacing between your paragraphs. A better solution is to let Word control spacing not only within but also between paragraphs. Simply block/select the paragraphs you would like to add spacing between ➔ Right-click the paragraphs ➔ choose Paragraph from the menu that appears ➔ click the Indents and Spacing tab ➔ add a 12 pt after ➔ OK button (see Figure VI-6).
2. **Spacing Measurements**: Generally, 6 points of space is a half line; 12 points is a full line; 18 points is one and a half lines and 24 points is two lines. So the 12 pt after shown above is adding one extra blank line after each paragraph.

3. **Spacing Before**: If you would like Word to automatically insert an extra space *above* each paragraph, use Spacing Before. Make the Spacing Before 12 pt. This will add a double space above each single spaced paragraph.

4. **Spacing After**: You can do the same thing as above, but the space will occur *after* each paragraph. Just follow the steps listed for Spacing Before only add the points to Spacing After.

5. **You Can Type Lines**: If you find the point system confusing, you can always delete the "pt" measure in the box and type "1 line". If you switch from points to lines, the up and down arrows will make adjustments in those terms.
D. **Automatic Tables of Contents:** Tables of contents should never be typed. Word and WP have features for generating them in a few seconds which also allows the tables to update themselves in the event the document is subsequently edited. In Word, you need to use the Styles feature to get your table of contents inserted and due to the complexity of that subject, it is beyond the scope of this class because it takes about 2 hours just to cover Styles.

E. **Automatic Table of Authorities:** Both Word and WP can generate these tables automatically from the document and they can be updated with two clicks to ensure that they're accurate no matter how much the document has been edited.

1. **In General:** Automatically creating a Table of Authorities can be very helpful, especially when the document will likely be changed subsequently. One minor change can throw off the entire Table. Your options for creating a table of authorities that will automatically update are to use Word's built-in feature or purchase a third-party add-in program.

2. **Using a Third Party Program:** An excellent program for this purpose which is faster, easier and actually provides more flexibility than Word's built in functionality is Best Authority by Levit & James, Inc. For more information about this program see www.levitjames.com/Products/Best-Authority.aspx. There are two versions of Best Authority, Light and Premium. You definitely want Premium. The only drawback of Best Authority is their bizarre "per litigator" pricing structure. The pricing is shown below, but you'll have to contact them for clarification on calculating your license cost (contact Ian Levit at ianlevit@levitjames.com or 703.771.1549).

<table>
<thead>
<tr>
<th>Number of Litigators</th>
<th>Price per Litigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 4</td>
<td>$360</td>
</tr>
<tr>
<td>5 to 9</td>
<td>$330</td>
</tr>
<tr>
<td>10 to 19</td>
<td>$300</td>
</tr>
<tr>
<td>20 to 49</td>
<td>$275</td>
</tr>
<tr>
<td>50 to 99</td>
<td>$250</td>
</tr>
<tr>
<td>100 to 249</td>
<td>$225</td>
</tr>
<tr>
<td>250 to 499</td>
<td>$200</td>
</tr>
<tr>
<td>500 to 999</td>
<td>$190</td>
</tr>
<tr>
<td>1000 +</td>
<td>$180</td>
</tr>
</tbody>
</table>

3. **Using Word's Built-In Feature:** The process of creating a table of authorities using Word's built-in feature involves two steps:

   a. Marking the citations.

   b. Generating the table of authorities based on the marked citations.
4. **Mark the Citations:**

   a. Click the References ribbon ➔ Table of Authorities group ➔ Mark Citation... button. A dialog box should appear.

   b. Click on the Next Citation button.

   c. Word will find the first citation in your document. Click back in the document and highlight the text with the full citation.

   d. With the citation highlighted, click in the Selected Text area in the dialog box. Word will insert the highlighted text.

   e. Select the proper Category (Cases, Statutes, etc.)

   f. In the Short Citations box, edit the cite as it appears in the document as the short citation.

   g. Click the Mark button or the Mark All button to mark all citations.

   h. Repeat the above steps to mark all citations and close the Mark Citation dialog box.

5. **Generate a Table of Authorities Based on Your Marked Citations:**

   a. Place the cursor where you want to insert the table of authorities.

   b. Select References ribbon ➔ Table of Authorities group ➔ Insert Table of Authorities button.

   c. Pick the desired format.

   d. Deselect the Use passim option.

   e. Deselect the Keep original formatting option.

   f. Select All under Category so that Cases, Statutes, etc. will appear in the table of authorities.

   g. Click OK to insert the table of authorities.

6. **Page Number Warning: NOTE: When the Table of Authorities fields are visible, the page numbers will not accurately reflect the actual page**
**numbers of the document.** This is because the Table of Authorities fields, when visible, take up significant additional space which will make your document appear longer than it is (and seemingly make the Table of Contents or Table of Authorities page number appear to be incorrect). Simply click the Home ribbon ➤ Paragraph group ➤ Show/Hide button . This will hide the Table of Authorities fields, and display accurate page numbers. Then update your Table of Authority page numbers (click in the Table of Authorities and click Update field).

*Sample Paragraph with TOA Fields Showing (bold added for emphasis)*


Figure VI-8

*Same Sample Paragraph with TOA Fields Hidden*


Figure VI-9

7. **Editing Table of Authorities Entries by Editing TOA Fields:** Microsoft Word "marks" entries by placing a Table of Authorities field immediately before
or after the citation. There are two types of Table of Authorities fields (1) long citation fields and (2) short citation fields. Once the fields are in the document, edit the fields directly to change the Table of Authorities entry.

8. **Long Citation Fields:** Long citation fields are used by Word to mark *the first instance* of a citation. Long citation fields have the following format:

```
{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1}
```

- **TA** is the field code for Table of Authorities
- **\l** designates how the Table of Authorities entry should be displayed in the actual Table of Authorities.
- **\s** is the short citation form that Word will use to search for and mark additional entries.
- **\c** is the category of the citation; i.e. Case, Statute or Rule.

![Mark Citation dialog box](image)

---

**Figure VI-10**
9. **Short Citation Fields:** Short citation fields are used by word to mark additional instances of a citation in a document. Short citation fields have the following format:

\{ TA \s "Smith" \}

\( TA \) is the field code for Table of Authorities, \( \s \) is the short citation form that Word will use to search for and mark additional instances.

![Mark Citation](image)

**Figure VI-11**

10. **How Word uses Long and Short Citation Fields:** Word uses the long citation field to mark the first instance of a citation, and the short citation field to mark additional instances. Therefore, there should be only one long citation field per unique citation and multiple short citation fields for additional instances of that unique citation. See the example below (emphasis added):
Example Text Showing Long and Short Citation Fields

Before the Act was adopted to promote this objective, public labor relations were characterized by wide and irrational variations among various local governmental entities relating to all manner of terms and conditions of employment. Not long ago, this court recalled that deplorable time. In Kettering v. State Emp. Relations Bd. (1986), 26 Ohio St.3d 50, 56, 26 OBR 42, 496 N.E.2d 983{ TA \l "Kettering v. State Emp. Relations Bd. (1986), 26 Ohio St.3d 50, 56, 26 OBR 42, 496 N.E.2d 983" \s "Kettering" \c 1}, this court stated ****

The decision below represents precisely the sort of return to the pre-Act “system” that this court condemned in Kettering{ TA \s "Kettering" }, supra. This court’s holding in Kettering{ TA \s "Kettering" } makes clear that, under the Act, a collective bargaining agreement binds the municipality and all of its agencies. No municipal agency can operate independently of that agreement; nor can it render the agreement a nullity by purporting to assume control over a term or condition of employment that is governed by the agreement.

11. Changing the format or text of the case citation in the Table of Authorities: Edit the long citation field to change the format or text of a case citation entry in the Table of Authorities. So for example, if the case name has to be in italics in the Table of Authorities, then make the case name italics in the long citation field. Select the name of the case contained within the quotation marks and make the text italics:

Change:

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1}

To:

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1}

This will cause the case name to display with italics in the actual Table of Authorities entry.

To force the case name to be on a separate line within the Table of Authorities, you need to insert a line break (SHIFT + ENTER) into the long citation field where you want to start a second line.

Change:

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1}

To:

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1}

Don't worry if the field looks strange in your document. The field does not print, but it will force a line break in your Table of Authorities.
TABLE OF AUTHORITIES

Cases
Kettering v. State Emp. Relations Bd. (1986) 26 Ohio St. 3d 50, 56, 26 OBR 42, 496 N.E.2d 983 ........................... 10
85 Ohio St. 3d 123, 54 N.E.2d 98 .................................................

Figure VI-12

12. **Table of Authorities Styles:** There are two Table of Authorities styles to be aware of (1) Table of Authorities, and (2) TOA Heading. These two styles control how the Table of Authorities is actually formatted. So, for example, to add a space between the word "Cases" and the citations, you need to modify the TOA Heading style to add a 12 pt space after the paragraph.

Similarly, to add a space between each citation, edit the Table of Authorities style to add a 12 pt space after the paragraph.

Figure VI-13

13. **Changing or Renaming Categories:** Word supports up to 16 different categories of citations, numbered 1 through 16. The labels for these categories can be changed on the Mark Citations dialog (References ribbon ➤ Table of Authorities group ➤ Mark Citations button). Open the dialog and click Category....
This will open the Edit Category dialog to rename (replace) any of the 16 categories. So to replace the Cases category with "Ohio Case Law", simply select Cases (i.e. category number 1), type "Ohio Case Law" in the Replace with box, and click Replace. Click OK, then Close.

Now update the Table of Authorities to update the label (right click on the Table of Authorities and select Update Field).
14. **Changing a Citation's Category:** Sometimes a citation gets placed into the wrong category. For example, a case gets marked as a statute. To change a citation's category, **edit the long citation field**, and change the category to the correct number. For example, if "Cases" is category 1, and "Statutes" is category 2, then to change the citation from being listed in "Statutes" to being listed in "Cases", change the category from 2 to 1. The category is defined in the Long Citation field after the "\c":

**Change:**

\{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 2\}

**To:**

\{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1\}

**F. Paragraph Glue:** There are features in Word and WP that will automatically hold separate paragraphs or headings together on a page or hold the lines of a paragraph together so that natural page breaks cannot separate them. Captions, headings, certificates of service, signature lines, acknowledgments and the like should be "glued" together so that page breaks can't possibly separate them in an unacceptable or awkward way.

1. **Keeping Text and/or Paragraphs Together:** Sometimes, you may not want text (paragraphs) to be separated by a page break. In other words, you want to glue the text together so it always appears on the same page. If you have a paragraph heading at the bottom of one page and the paragraph it should be attached to at the top of the next page, it is always wrong to insert hard returns (hit the Enter key) above the paragraph at the bottom of the first page.

2. **To Keep Paragraphs Together:** This function keeps different paragraphs together on the same page.

   a. Click your cursor into the paragraph *under which* you want to apply glue. Don’t select anything, just click. In the screen shot below, you would simply place your cursor in the paragraph entitled
“Loans”. You would not select paragraphs 3.3 and (a) because that would result in gluing together more paragraphs than you intend.

Figure VI-17

b. Either right-click the paragraph and choose Paragraph from the menu that appears - or - click the Home ribbon ➤ Paragraph launcher. Once you’re in the Paragraph dialog, click the Line and Page Breaks tab.

c. Check the Keep lines together box and the Keep with next box and click OK. Leave the Orphan/Widow box selected. Click the OK button.

Figure VI-18
3. **To Keep Text within a Paragraph Together:** This function keeps the lines from a paragraph or paragraphs from being broken by a natural page break. For example, in the screen shot below, I don’t necessarily want to glue paragraph (e) to paragraph (f); but I want to keep (e) together on the same page since it’s only 3½ lines.

![Screen Shot](image_url)

- **Figure VI-19**

  - a. To take care of this issue, place your cursor anywhere in the paragraph in which you’d like to keep the lines together.

  - b. Either right-click the paragraph and choose Paragraph from the menu that appears - or - click the Home ribbon ➤ Paragraph launcher ➤ Line and Page Breaks tab.

  - c. Check the Keep lines together box. Leave the Orphan/Widow box selected.

G. **Proper Formatting Defaults:** Both Word and WP have the capability of setting up document defaults so that formatting is consistent throughout the document and editing it won’t cause unexpected formatting results. This must be understood and properly set up in the templates you create.

1. **How To Fix Word's Formatting Defaults:** Word's formatting defaults are frankly terrible for a legal environment and it’s important that you change them to match whatever formatting standards your office has adopted. By doing so, every time you create a new document, the formatting you want will already be present.
2. **Change Your Default Font Formatting**: If you don't like Calibri 11 or Word's other defaults related to Fonts, simply follow these steps to fix them:

   a. Open a blank document in Word

   b. Click Home ribbon ➤ Font launcher. This will make the Font dialog appear.

   ![Font Launcher](image)

   Figure VI-20

   c. Make your adjustments to the font size and click the Default button (Word 2007: Default… or Word 2010/13/16: Set as Default) at the bottom of the dialog.
d. In Word 2007, you'll see the following dialog/warning. Click Yes and you're done!

![Image of Font dialog box]

Figure VI-21

In Word 2010/13/16, you'll see the following dialog. Make sure you check All documents based on the ... before you click the OK button.

![Image of Office Word dialog box]

Figure VI-22
3. **Change Your Default Paragraph Formatting**: Simply follow these steps to fix them:

   a. Open a blank document in Word

   b. Click the Home ribbon ➤ Paragraph launcher. This will make the Paragraph dialog appear.

   c. Recommended changes to the Paragraph dialog (Indents and Spacing tab):
      i. Leave left and right indentation at 0" and Special at "(none)"
      ii. Make spacing before and after 0 pt.
      iii. Line spacing Single
      iv. If you prefer, switch the Alignment to Justified

   d. In Word 2007, after making your paragraph formatting adjustments, click the Default... button at the bottom of the dialog. Next, you'll see the dialog/warning in Figure VI-24. Click Yes and you're done!

   ![Figure VI-23](image)

   ![Figure VI-24](image)

   In Word 2010/13/16, click the Set As Default button, and you'll see the dialog in Figure VI-25. Make sure you check All documents based on the... before you click the OK button.
4. **Change Your Default Section Formatting**: Simply follow these steps:

a. Open a blank document in Word

b. Select the Page Layout ribbon ➤ Page Set Up launcher. This will make the Page Setup dialog appear.

c. Recommended changes to the Section dialog:

   i. Margins tab: Most legal users prefer 1" margins on all sides

   ii. Layout tab: If you normally do not page number the first page of your documents, check the box for Different First Page.

d. After making your page setup adjustments, click the Default button (Word 2007: Default… or Word 2010/13/16: Set As Default) at the bottom of the dialog. Next, you'll see the dialog/warning in Figure VI-26. Click Yes and you're done!

5. **Default Settings Do Not Affect Existing Documents**: It is important to note that the foregoing changes to your default template do not affect, in any way, documents you've created in the past. In other words, when you open a document you created before making these changes, it will retain its original formatting and will not automatically morph to your new default settings. The changes made previously will only apply to new documents you create in Word.
Initially, you might wish that default setting changes would automatically affect your existing documents. However, it would be extremely problematic if that were the case because every time you created a document and formatted it just the way you wanted, it would completely reformat itself as soon as someone else opened it in Word (assuming that their formatting defaults weren’t exactly like yours).

VII. THE CASE FOR COMMERCIAL DRAFTING SYSTEMS ("COMMERCIAL SYSTEMS"):

A. Benefits of a Commercial Systems: Assuming a broad range of core document styles or many and varied clause options, Commercial Systems offer advantages over a forms-only convention in that they:

- May enable a user to draft extremely sophisticated documents with limited knowledge of the subject area
- Help minimize malpractice risk
- Good ones have an extremely fast "ramp up" time. In other words, you could buy a good Commercial Systems, spend a couple of weeks intensively studying the system and subject area, and you're ready to go.
- They can save you a tremendous amount of time compared to compiling template documents yourself.
- When the law changes, many Commercial Systems provide updates so you're always current with the latest developments.
- Some Commercial Systems provide free or fee-based educational seminars where you can learn more about the area of law they address.
- Most have a free demonstration.
- Some have list servs or other ways in which members or subscribers can connect and share information or help one another. This can be extremely valuable.
- Some Commercial Systems are customizable so you can modify the language they produce or add your own forms or templates.
- Technical support.
- Many Commercial Systems work in Word and/or WordPerfect.

B. Drawbacks of a Commercial Systems:
• They can be very expensive and many require that you pay annually.

• You only get the documents included in the system and it may be difficult or impossible to add additional ones.

• Some may not offer documents for every state.

• In a pure subscription arrangement, you don't own anything. You can't use the language contained in the documents for any other purpose and if you stop paying your annual fee, the system stops working.

• You're often stuck with the language the system provides and it is impossible or difficult to edit it.

• Some Commercial Systems cannot be customized so that the resultant documents come out the way you want without editing. If you can customize the system, it's often difficult to do so.

• Some users of high-end Commercial Systems complain that the system is so complicated that they're very difficult to fully grasp; and it may be impossible for a non-lawyer support staff person to ever figure them out completely.

VIII. THE CASE FOR ADDING DOCUMENT ASSEMBLY TECHNOLOGY TO YOUR TEMPLATES:

A. Unmatched Speed and Accuracy: A document assembly system is the proverbial magic bullet for document-intensive areas of practice. If you're in such a practice (estate planning, real estate, banking, contracts, employee benefits, etc.), nothing else you can do will have a greater impact on your efficiency than automating your document production. It's one of the few technologies that can literally revolutionize the way you work. For example, assume you have a complex document with hundreds of optional paragraphs (such as a complex Revocable Trust) which presently requires four hours to create from first to final draft. After converting the document into a HotDocs template, the same document generation should take approximately ten minutes. The time savings are that dramatic.

B. Allows You To Safely Offer Flat Fees: The time savings realized with document assembly systems are so significant that they require a move to flat fee or "value billing" instead of hourly billing. Of course, this doesn't mean that you should charge less for services rendered. It simply means that any uncertainty regarding the time necessary to generate the documents has been removed. Therefore, there is no risk in quoting a flat fee (at least for the document generation aspect of the service). The net effect is that fewer resources are consumed to produce better documents and clients are happier because they didn't have to worry about an unexpectedly high hourly fee.
C. **You Don't Have To Build It Yourself:** You can learn to automate templates yourself, but it takes a significant investment of time. If you don't have the time to invest or would rather practice law, then you can always hire someone to build the system for you (using your documents, of course). For example, Affinity Consulting Group can teach you how to automate documents yourself or we can automate them for you.

D. **Higher Accuracy:** Document assembly and word processor automation systems are much more accurate than Find, Rename & Modify because they only require the user to enter case-specific facts and the items that change (party names, etc.). The template does the work of including the appropriate paragraphs, excluding the irrelevant ones, verb conjugation, punctuating lists, calculating numbers and dates, correcting personal pronouns and replacing the items in need of replacement. For many people witnessing this method of document generation for the first time, it is nothing short of an epiphany.

Documents generated from document assembly systems are more accurate though much less time is spent generating them; and training time for new employees is reduced since they must only be shown how to answer the questions.

E. **Higher Profitability:** If you're generating more accurate documents in far less time and consuming far fewer resources in the process, profitability naturally goes up. The return on investment is fast and furious; usually only a few months for most projects. For example, let's assume that an estate planning lawyer and it takes you about 10 hours for the initial meeting and the time necessary to draft an entire set of estate planning documents for the average client. Many transactional lawyers have switched to a flat-fee schedule so let's also assume that you charge a flat fee of $2,000 for the average plan. Dividing that fee by the time it takes you to produce the documents means you're realizing about $200 per hour. However, if you automated your document production, your total time spent could easily drop to 1.5 hours (including the initial meeting). That would raise your effective hourly rate to a whopping $1,333 per hour. Now that's not bad!

Let's take that a step further and look at your cost savings. Assume that your cost of production works out to about $100/hour (salary, benefits, materials consumed, etc.) for the time you used to spend. Therefore, if it was taking you 10 hours, then your cost of production was $1,000. With a drafting system, your cost of production drops to $150, or a savings of $850 per transaction. If you're averaging just 6 new estate planning clients a month, then your monthly savings is $5,100. You can use that figure to determine how much it would make sense to spend on automating your documents. You may have originally thought that a $10,000 price tag for automating was completely out of the ballpark. Now you realize that you'd recoup that investment inside of two months. Since most
experts say that project with a payback period of 12 months or less should be implemented, the idea of automating your documents pretty quickly moves from "that's way too expensive" to "when do we get started?"

It should also be noted that document assembly can pay big dividends even with the most simple documents. Let's say, for example, that your firm produces 50 letters a week of various types. They could be anything from a "confirming our initial appointment and here's what you need to bring" letter to a fax cover sheet to a simple "enclosed please find..." letter. If those letters presently take 8 minutes on average to complete, then that's 6.67 hours per week. Now let's assume they're automated, and the time necessary to complete drops to an average of 1 minute (very realistic). You're now down to .83 hours per week. If you multiply that time savings by $100/hour, that's $584/week, $2,336 per month and $28,032 per year. Regardless of the dollar savings, an extra 5.84 hours per week is nothing to sneeze at.

F. **Faster and More Sophisticated Template Development**: Automation options native to Word and WordPerfect are very capable. However, to build sophisticated systems using only the tools within the word processor (Word, in particular) can be exceedingly difficult and slow. For example, I worked with a firm that had a Visual Basic programmer on staff who was working to automate several departments within the law firm using Microsoft Word's native functionality. Once they saw how efficient HotDocs could perform this task at a higher level, they immediately abandoned their Visual Basic coding. According to the gentleman who was doing the programming, he could create templates 3 times as fast using HotDocs (compared to Visual Basic) and had more advanced tools to work with.

G. **Data Sharing**: For practice areas which typically require the production of several related documents, the entire set of documents can be automated so they share common information and may be generated simultaneously.

H. **Form Consolidation**: For example, let's say an estate planning attorney has 8 different form templates for a revocable trust. The differences between them could be fact pattern variations (for example, one might be a joint trust, one might be a single grantor trust; there may be different templates for a Marital outright, a QTIP or a General Power of Appointment). However, those templates would certainly share a lot of language not least of which was boilerplate text. Document assembly software would allow that lawyer to create a single Revocable Trust template which could produce any of the 8 original varieties based upon how the questions were answered in the interview. As such, there is only one template to edit and maintain; and if common language is edited once, it automatically affects all possible documents derived from that template.
I. Database Integration and Third Party Program Integration: Another great benefit of document assembly is that most applications can integrate with existing ODBC-compliant databases. For example, HotDocs integrates with Outlook, Access and many other common database programs. HotDocs also links with major case/practice management programs such as Amicus Attorney, Time Matters, Abacus Law, Practice Master, ProLaw and many others. Even accounting programs like PCLaw offer integration with HotDocs. Many of these programs come with included integration features which minimize the effort on your part to make it happen. It is also fairly easy to integrate with your own custom and other out-of-the box databases you may use in your practice.

The most obvious benefit of integration is that you already capture data about clients and matters in your existing practice management software. Using the integration tools and techniques allow you to pass that information along to your automated documents with little effort on your part. In addition, because the data does not need to be reentered the risk of inaccurate or incorrect data is greatly reduced. For example, a classic integration example is taking information entered into the practice management system and automatically generating an engagement letter. Another example is a large firm which does commercial loan work and has created a database which holds all of the pertinent loan information throughout the life of the loan. At any time, with a few mouse clicks, a lawyer will generate any or all (in this case about 30) available documents in a matter of five or six seconds. Before the integration was set up this process could take hours and the loan data was being reentered several times throughout the process.

J. Complete PDF Forms: If you have PDF forms to complete as part of your document assembly initiative, make sure the program you’ve chosen can fill in the fields in those documents as well. In the perfect world, you could fill out PDF forms as easily as you generate Word or WordPerfect documents. HotDocs, for one, is capable of this.

K. True Document Assembly Not Always Necessary: In spite of the foregoing, sometimes true document assembly is overkill. For example, if you're only generating documents with simple fill in fields and you don’t really need to calculate anything or gather lists or do anything really "fancy," then you can probably get by with the automation tools already present in Word or WordPerfect. Word makes this task a bit more difficult than WordPerfect, but it's a fast, easy alternative for simple, straight-forward drafting.

L. Document Automation on the Web: Many of the document automation programs today provide the ability to deliver automated documents through a web browser. The interview is presented to the user in a web form and the documents are generated on a web server and made available for downloading.
This example shows the same interview in the example above but presented through Internet Explorer.

There are very few differences in the look and functionality of the interview. Using web technologies greatly enhances the flexibility of deploying automated document templates and customizing how those templates are used in legal practice.

M. Document Assembly Considerations:

1. How To Determine Documents Suitable for Automation: Draw a graph like the one below and plot your documents. Documents that are plotted in Quadrant I are good ones to start with when learning a document assembly program. You create them frequently, but they're pretty easy. Things like fax cover sheets and enclosed-please-find letters tend to fall within this quadrant. Once you have practice and are a lot better at template development, you can start working on documents plotted in Quadrant II. These are the documents that will really improve your bottom line once they're automated. On the other hand, documents automated in Quadrants III and IV are probably not worth the effort.
2. **Creating the Master Document:** When you create a new template, in most cases you'll be basing the template on an existing document you commonly draft. Therefore, it's a good idea to start with a document you feel is the best example of the document for which you're going to create a template. Before creating the template, you'll need to add in all possible optional paragraphs that could occur in that type of document (in the order they could occur) and then "markup" the document. We refer to a document which contains all possible options for a document of that type and which has been marked up as a **Master Document**. This concept is best illustrated with an example. Let's say you're going to make a template for a Promissory Note like the one shown on the following page as **Exhibit 1** on Page 55.

The first step is to identify changeable text. To make them easy to spot when you're automating the template, consider wrapping them with square brackets, and also add notes so you'll know what the options are. For an example, see **Exhibit 2** on Page 56. The next step is to identify optional paragraphs, add in optional paragraphs that aren't included in your base document and state the tests for their inclusion. For an example, see **Exhibit 3** on Page 58.
EXHIBIT 1 - Initial Document
PROMISSORY NOTE

FOR VALUE RECEIVED, the undersigned JOHN A. DOE and JANE M. DOE (hereinafter collectively referred to as "PAYOR"), promise to pay to the order of PAUL J. UNGER (hereinafter referred to as "PAYEE"), or holder, at 2001 Neil Avenue, Columbus, OH 43235, or at such other address as the holder hereof may from time to time designate in writing, the principal sum of Fifty Five Thousand and 00/100 Dollars ($55,000.00) with interest thereon at the rate of eleven percent (11%) per annum, payable in sixty (60) monthly payments of $1,195.83 commencing on the 1st day of February, 2000, and continuing on the first day of each month thereafter with the entire outstanding balance of interest and principal due and payable on January 31, 2005.

This Note may be prepaid in whole or in part, at any time, without penalty.

This note is secured by mortgage of even date herewith, executed and delivered by PAYOR, which is a lien on a certain parcel of real estate situated in Franklin County, Ohio, and more fully described in said mortgage.

If any installment of this note is not paid when due and remains unpaid for ten (10) days following the due date, such payment shall be subject to a five percent (5%) late fee. If any monthly installment under this note is not paid when due and remains unpaid for a period of thirty (30) days, the entire principal balance outstanding and accrued interest thereon shall at once be due and payable at the option of the note holder and such outstanding balance shall bear interest at the rate equal to five (5) percentage points higher than the original interest rate or sixteen percent (16%) per annum until paid.

All persons now or hereafter liable for the payment of the principal or interest due on this note, or any part thereof, do hereby expressly waive presentment for payment, notice of dishonor, protest and notice of protest, and agree that the time for the payment or payments of any part of this note may be extended without releasing or otherwise affecting their liability on this note, or the lien of any mortgage securing this note.

This note was executed in Franklin County, Ohio.

PAYOR

____________________________
John A. Doe

____________________________
Jane M. Doe
EXHIBIT 2 - Markup Phase I
PROMISSORY NOTE

$[Note Amount] [Execution Date - August 28, 2003] [Execution City], Ohio

FOR VALUE RECEIVED, the undersigned [Payor Name - all caps - could be more than one] (hereinafter [collectively - include if more than 1 Payor] referred to as "PAYOR"), promise[s] to pay to the order of [Payee Name - all caps - could be more than one] (hereinafter [collectively - include if more than 1 Payee] referred to as "PAYEE"), or holder, at [Payee Full Address], or at such other address as the holder hereof may from time to time designate in writing, the principal sum of [Note Amount - in text = Fifty Five Thousand and 00/100 Dollars] ($[Note Amount]) with interest thereon at the rate of [Note Interest Rate - text - could include hundredths of a percent] percent ([Note Interest Rate]% per annum, payable in [Note Number of Payments - text] ([Note Number of Payments]) monthly payments of $[Note Payment Amount] commencing on the [Note Date of First Payment - 1st day of September, 2003], and continuing on the first day of each month thereafter with the entire outstanding balance of interest and principal due and payable on [Note Maturity Date - calculate this].

This Note may be prepaid in whole or in part, at any time, without penalty.

This note is secured by mortgage of even date herewith, executed and delivered by PAYOR, which is a lien on a certain parcel of real estate situated in [Secured Property County] County, Ohio, and more fully described in said mortgage.

If any installment of this note is not paid when due and remains unpaid for ten (10) days following the due date, such payment shall be subject to a [Note Late Fee - text] percent ([Note Late Fee]% late fee. If any monthly installment under this note is not paid when due and remains unpaid for a period of thirty (30) days, the entire principal balance outstanding and accrued interest thereon shall at once be due and payable at the option of the note holder and such outstanding balance shall bear interest at the rate equal to [Note Acceleration Interest Penalty - text] ([Note Acceleration Interest Penalty]) percentage points higher than the original interest rate or [Note Accelerated Interest Rate - text - calculate this] percent ([Note Accelerated Interest Rate] %) per annum until paid.

All persons now or hereafter liable for the payment of the principal or interest due on this note, or any part thereof, do hereby expressly waive presentment for payment, notice of dishonor, protest and notice of protest, and agree that the time for the payment or payments of any part of this note may be extended without releasing or otherwise affecting their liability on this note, or the lien of any mortgage securing this note.
This note was executed in [Execution County] County, Ohio.

PAYOR

________________________________________
[Payor Name]

________________________________________
[Payor Name]
EXHIBIT 3 - Markup Phase II
PROMISSORY NOTE

$[Note Amount] [Execution Date - August 28, 2003]
[Execution City], Ohio

FOR VALUE RECEIVED, the undersigned [Payor Name - all caps - could be more than one] (hereinafter [collectively - include if more than 1 Payor] referred to as "PAYOR"), promise[s] to pay to the order of [Payee Name - all caps - could be more than one] (hereinafter [collectively - include if more than 1 Payee] referred to as "PAYEE"), or holder, at [Payee Full Address], or at such other address as the holder hereof may from time to time designate in writing, the principal sum of [Note Amount - in text = Fifty Five Thousand and 00/100 Dollars] ($[Note Amount]) with interest thereon at the rate of [Note Interest Rate - text - could include hundredths of a percent] percent ([Note Interest Rate]% per annum, payable in [Note Number of Payments - text] ([Note Number of Payments]) monthly payments of $[Note Payment Amount] commencing on the [Note Date of First Payment - 1st day of September, 2003], and continuing on the first day of each month thereafter with the entire outstanding balance of interest and principal due and payable on [Note Maturity Date - calculate this].

ASK: Is there a prepayment penalty? If Y, insert this

If this Note is prepaid in whole or in part, in advance of the payment due dates, the PAYOR shall pay a pre-payment penalty to Payee equal to [Note Prepayment Penalty - text] Percent ([Note Prepayment Penalty - text]%) of the outstanding balance of the loan as of the date of the prepayment.

Otherwise, this

This Note may be prepaid in whole or in part, at any time, without penalty.

End Option

ASK: Is this note secured with real estate?

This note is secured by mortgage of even date herewith, executed and delivered by PAYOR, which is a lien on a certain parcel of real estate situated in [Secured Property County] County, Ohio, and more fully described in said mortgage.

End Option

If any installment of this note is not paid when due and remains unpaid for ten (10) days following the due date, such payment shall be subject to a [Note Late Fee - text] percent ([Note Late Fee]%) late fee. If any monthly installment under this note is not paid when due and remains unpaid for a period of thirty (30) days, the entire principal balance outstanding and accrued interest thereon shall at once be due and payable at the option of the note holder and such outstanding balance
shall bear interest at the rate equal to [Note Acceleration Interest Penalty - text] ([Note Acceleration Interest Penalty]) percentage points higher than the original interest rate or [Note Accelerated Interest Rate - text - calculate this] percent ([Note Accelerated Interest Rate] %) per annum until paid.

All persons now or hereafter liable for the payment of the principal or interest due on this note, or any part thereof, do hereby expressly waive presentment for payment, notice of dishonor, protest and notice of protest, and agree that the time for the payment or payments of any part of this note may be extended without releasing or otherwise affecting their liability on this note, or the lien of any mortgage securing this note.

This note was executed in [Execution County] County, Ohio.

PAYOR

________________________________________
[Payor Name]

________________________________________
[Payor Name]
3. **Do it Yourself v. Consultants:** After you've decided you want to implement document automation into your practice, you must decide whether to "do it yourself," hire a document automation consultant or a combination of both. Generally you can save time and money by hiring a consultant. It takes time to become skilled at document automation and your time is valuable to the profitability of your firm. If you bring in a consultant you benefit from the efficiencies and expertise from years of experience in working with firms likes yours. Also with a consultant you will have more predictable and controllable costs, the project will likely be completed more quickly, and the cost will be lower. On the other hand, you know your documents better than anyone else and if you are one who likes to get your hands into technology then automating your documents is a great way to do exactly that. Either way it is important to weigh the costs and benefits of both approaches and decide what works best for you.

N. **Free Trials of Document Assembly Software:** Before you spend money on it, you can try HotDocs for 30 days. Just go here: [http://tinyurl.com/q5lzrx3](http://tinyurl.com/q5lzrx3)

IX. **AUTOMATION STUMBLING BLOCKS:** There are obvious compelling reasons to automate your document generation. So why isn't every legal document being drafted this way? There are several reasons and being aware of them will help you overcome them.

A. **Productivity Paradox:** If a private firm bills time, then they have a strong disincentive to employ techniques that reduce the amount of time they spend to render a particular service. As long as hourly billing persists, automation makes little financial sense.

B. **Insufficient Training:** If the project is undertaken in-house, the individuals responsible for the automation are rarely given enough training (particularly if a document assembly program is being utilized). With document assembly in particular, it can take months of practice to become a skilled user of the tool.

C. **Unsuitable Documents:** Unless a lawyer drafts new documents from a blank piece of paper every time, then those documents can be automated. I have never met a lawyer who doesn't craft new documents from templates or pieces and parts of existing documents. However, many lawyers use templates or starting point documents that are related to one another (due to practice area), but which are completely dissimilar due to the fact that the lawyer has never audited the documents and tried to create similarity where it is appropriate. For example, let's assume a lawyer drafts employment agreements for hourly workers and salaried workers. Those agreements could contain a lot of duplicate language in at least the boilerplate provisions. However, they may not share a single paragraph unless the lawyer has made an effort to standardize them. Although it would make sense to combine those documents into a single template for
purposes of automation, it may be impossible to do until the underlying documents are re-written so that the common provisions are actually consistent.

D. **Lawyer Push-Back:** A successful document assembly project is going to encapsulate an entire decision tree into the system so that it can produce perfectly customized documents with nothing more than the right answers to on-screen questions. Some lawyers feel threatened by this and simply aren’t comfortable with technology which can do in seconds what was previously done by the lawyer through hours of work. I’ve heard more than one lawyer say over the years, "after this project is done, what are they going to need me for?" Support staff often feel even more threatened by this (sometimes justifiably so) and we have seen support staff make overt attempts to torpedo an automation project. The cold, hard reality is that a very high percentage of legal work is routine legal work. To the extent routine legal work involves the generation of documents by a lawyer, then it can be automated, systematized and in some cases, commoditized. These facts make lawyers uncomfortable for obvious reasons, but they are true nonetheless.

E. **Initial Project Too Difficult:** This is another stumbling block for projects undertaken in-house. Most lawyers quickly realize that document automation will pay the biggest dividends with the most complex and time-consuming documents. However, those are the wrong documents to start with because of their complexity. For the person in charge of the project, it's like learning to swim by being pushed into the deep end of the pool. If a firm or department wants to automate a complex set of documents, they should start with a simple one so that the developer has an opportunity to cut their teeth on something that isn't going to overwhelm them on the first day. For more information on how to choose appropriate documents to start with, see paragraph . on page .

F. **Not Enough Time To Finish a Project:** Law firms and legal departments often task a support staff person or lawyer with automation projects and ask them to work on it "between projects" or "in their spare time." Of course, the time required to work on the project doesn't materialize or doesn't come in big enough chunks to get anything meaningful done. In our experience, if you don't make these projects part of someone's job description and allocate consistent time to the task, nothing gets done.

G. **Person Tasked With Project Does Not Understand the Substantive Law:** This is usually when a firm or department decides that someone from the IT/computer staff should automate the documents because they're more tech savvy. Of course, those IT folks tend to know nothing about the substantive area of law (strike one); they typically have little experience with the word processor environment in which the development occurs (strike two); and they cannot get
enough face time with the lawyers who do understand the area of law to get questions answered timely and keep the project moving (strike three).

H. Faulty or No Return On Investment ("ROI") Analysis: Many times, a law firm or legal department will reject an automation proposal based solely on the price tag. That approach is fine as long as an ROI analysis is conducted to confirm or deny whether the project is worth doing. Many times, a project that sounds too expensive will pay for itself in 2 to 3 months. Therefore, it is essential to go through the ROI analysis before deciding yes or no on any particular project.

1. What Is The Return On Investment of The Purchase? Technically, ROI is an estimate of the financial benefit (the "return") on money spent (the "investment") for a particular project. When calculating your cost, only include direct costs and expenses that are driven by the proposed project. Your calculation of return should include tangible benefits (bottom-line revenue increases or cost savings) and intangible benefits. When evaluating benefits, consider the following criteria:

   a. Number of people helped: The higher the number of people helped by the proposed project, the higher the ROI. In this case, everyone in your office could use the system.

   b. Frequency of use: The more frequently an application will be used, the higher the ROI.

   c. Cost of production: The higher your internal cost to deliver the service or product, the greater the benefit from automation or technical assistance.

   d. Potential to re-use: The greater your potential to re-use the data or information in the proposed new system, the higher the ROI.

   e. Communication efficiencies: The easier the proposed project makes it for your firm to communicate with clients or your employees to collaborate and communicate with one another, the higher the ROI.

   f. Increased accuracy: The more a product or service increases accuracy, the higher the ROI.

2. Calculating Cost Savings: Before you can figure out savings, you must first figure out what your costs are. Therefore, you'll need to conduct a workflow analysis. Determine what steps are involved, how long each step takes and the costs associated with each step. After you've got that down, figure out how many of those transactions you average per week, month
and year. This will help you determine your true costs so you can figure out what your savings might be. While you're doing this, you should consider which steps, if any, can be eliminated. The overall processes should also be scrutinized because it won't help to automate a bad process.

3. **Payback Period**: This is the time it takes for the return to equal the investment. With technology projects, most experts agree that you should look for payback periods of one year or less. Furthermore, once a project is past its payback period, you should not be afraid to discard it for something better.

4. **Other Factors Affecting ROI**:
   a. **Will The New Technology Increase The Competence Of Your Staff And Make The Office More Efficient?** The best technology initiative will fail if your colleagues and staff refuse to use it or don't understand it sufficiently to use it. You have to think about this issue in advance. We recommend bringing the staff into the technology decision-making process early. This is essential if they are the ones who will be working with the new hardware or software. While they cannot dictate what you buy, their ideas can improve it, and their participation is essential if the system is to work. Without this participation and "buy-in," it can be an uphill battle.
   b. **Will The New Hardware/Software Allow You To Do Something You Couldn't Do Before?** For example, if you currently refer to outside counsel all transactions of a particular type, then a new piece of technology may allow you to pull that work back inside your office.
   c. **Will The Quality Of Your Services Be Improved?** Any technology that enables you to provide more comprehensive, faster, more accurate or less expensive service to your clients should be given special consideration. This also applies to technology that allows you to communicate better with your clients.

5. **Sample Analysis**: In my professional experience, lawyers have a difficult time ascertaining their hard and soft costs associated with rendering a particular service. For example, a solo estate planning lawyer might be presented with an option of buying an estate planning document assembly system. Let's say the cost is $12,000. Many lawyers will dismiss that cost immediately as too expensive and not give it a second thought. However, the return on investment analysis might have worked out like this:
a. Lawyer handles 4 plans per week @ $750 each (flat fee).

b. Average wage + benefits = $30/hr (internal costs); and the typical transaction takes 8 hours from start to finish

c. Therefore, the current profit per plan = $510 or $97,920/yr

d. Automated estate planning system cost = $12,000

e. Using the proposed system, the lawyer's total time to complete a plan drops from 8 hours to 1.5 hours

f. Profit per plan goes to $705 or $135,360/yr

 g. Therefore, revenue would increase by $37,440 in the first year and the system would have paid for itself by the 4th month of use. Most experts on this subject say that if the payoff is 12 months or less, then it is a good idea to pull the trigger.